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LAB.1 : Getting Started with Windows 7

Part | : Logging on and Good Password Practices

Logging on:

e Press the three buttons: CTRL-ALT-DELETE at the same time.

e Enter your USERNAME and PASSWORD into the window that appears.

Good Password Practices: password must be changed every 60 days. Your password must:
= be between 6 and 8 characters in length (inclusive)

= be easy to remember

= Not be your first name, surname or login.

= Not be asingle real word e.g. book.

= Not be "qwerty" or something similar, as it is amongst a hacker's favorite first attempts.
Good Password Examples:

« tacOsnax : 8 characters, no real words, but easy to remember.

« P@sswOrd: use numbers or special characters instead of letters in words, ("&","1","#").

« 1000$0Kor easily remembered keyboard patterns instead of words.

Part Il : Introduction to the Desktop

v" Desktop Customizations
1. Screen resolution.

2. Gadgets: To add gadgets to the Windows 7 desktop, follow these steps:
Step 1. Right-click anywhere on the desktop and choose Gadgets.

Step 2. Drag and drop the gadget from the menu to the desktop, or double-click the gadget to
add it to the desktop, or right-click the
gadget and choose Add.

3. Personalize: In the Personalization
window, you can change the desktop
appearance, display setting, and sound
settings.

Windows 7 Personalization window—>
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LAB.1 : Getting Started with Windows 7

Task:
- Write down the Screen resolution for your computer.
- Show two of the Gadgets available on your computer.
- Change the background, screen saver, and window colors on your computer.

v" Working with Icons : My Documents, My Computer, The Recycle Bin

v Arranging lcons on the Desktop:
Task: Arrange icons on the desktop using one of the following:

a. by name b. by size c. by type d. When last modified.

v Changing the Icon:
Right click on the icon > PROPERTIES>SHORTCUT tab->CHANGE ICON

v Changing the size of the icons:
Click and hold down the Ctrl key and then use your scroll wheel on your mouse to resize the

icons

v Shortcuts:
To create shortcut: Right mouse click on an empty part of the desktop> NEW

—->SHORTCUT

Task: Create a folder with your name on C drive, then change the icon, and create a shortcut on
desktop.

v' Desktop features:

« Shake - Minimize all windows that are not being used by clicking and holding the title bar
of one window and shaking it with the mouse. Repeat the action to maximize all of the
windows.

« Peek - View the desktop icons that are behind open windows by placing your cursor over
the Show desktop button found at the right edge of the taskbar. This makes the open
windows transparent. Click the button to minimize all windows.

« Snap - Resize a window by dragging it to one of the edges of the screen. Dragging the
window to the left edge of the desktop fits the window to the left half of the screen.
Dragging the window to the right edge of the desktop fits the window to the right half of
the screen. Dragging the window to the top of the screen will maximize the window.
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LAB.1 : Getting Started with Windows 7

Part Il : The Taskbar and Start Menu

v" Customize the taskbar

Task: Fill in the blanks:
1. To unlock the taskbar:
2. To move the taskbar:

v Pinned applications:
To add an application to the taskbar (or start menu) for easy access, right-click the icon of an
application and select Pin to taskbar (Pin to start menu).

v Help and Support
START button-> HELP AND SUPPORT (You can also hit F1)

v Arrange windows
To arrange windows automatically: right-click an empty area of the taskbar and then choose
cascaded, stacked, or side by side.

Toolbars r

Cascade windows
Show windows stacked
Show windows side by side

Show the desktop
Start Task Manager

I v Lock the taskbar
I Properties

Part IV : Task Manager

The Task Manager allows you to view all applications that are running and to close any
application. To open the Task Manager, press CTRL-ALT-DEL and select Start Task
Manager.
Alternatively, you can open the Task Manager by right-clicking the taskbar and selecting Task
Manager
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LAB.1 : Windows 7

Part | : Control Panel

System and eﬁ

To view and change system and security status, back up and restore

file and system settings, update computer, view RAM and processor

Security
speed, check firewall and more.
- To check network status and change settings, set preferences for
Network and u. ) , )
— sharing files and computers, configure internet display and
Internet _
connection.
Hardware and [/ To add or remove printers and other hardware. change system sounds,
‘
Sound ﬁ play CD's automatically, conserve power. update device drivers.
— Uninstall programs or windows features. uninstall gadgets, get new
Programs L.: 4 :
& programs from the network or online.
Change user account setting and passwords, and set up parental
User Accounts

controls.

Appearance and

Change the appearance of desktop items. apply a theme or screen

and Region

Personalization saver to your computer, or customize the Start menu and taskbar.
Change the date, time, and time zone for your computer. the language
Clock, Language

to use, and the way numbers, currencies, dates, and times are

displayed.

| @ 7 |&

&

Ease of Access

Adjust your computer settings for vision, hearing, and mobility, and
use speech recognition to control your computer with voice

commands.

v" What software versions do | have and what is on my computer?
Right mouse click on MY COMPUTER icon - PROPERTIES

Task: open the properties on your computer and find out the software version.

Computer Skills Lab
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LAB.1 : Windows 7

Part Il : Windows Libraries

When Windows is installed, each user has four default libraries: Documents, Music, Pictures,
and Videos.

A library presents content from different MM = Il}
locations in the same folder. You can search a T )

library, and you can filter the content using | %< - e B x

criteria such as filename, file type, or date | =« .
modified. e

To create a new library, open a folder and | 4«
select Libraries > New library.

To customize a library, right-click the library
and click Properties. The Properties window
allows you to add folders to the library by
clicking Include a folder. You can also change
the icon for the library and customize how items are arranged.

Part Il : Folders and File Management

&€ Extra Large Icons

v Change thumbnail size and file details E—)

. . [ | | =l Large Icons
v' Selecting Files and Folders:

&= Medium Icons
1. Single Selection: and click once

2. Scattered Selection: Use CTRL key .

=]=]m|
==: Small Icons

3. Block Selection: Use SHIFT key . EEList
=== Details

4. Selecting All: Use CTRL+A. - t
== Tiles

g=
2= Content
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LAB.1 : Windows 7

Part |V : Files Name, extension and Path

v

File Extensions:
= .doc, .docx : Microsoft Word files
XIs : Microsoft Excel files
pdf : Adobe Acrobat files
.ppt : Microsoft PowerPoint files
JPG, .Bmp: Image File
.Mp3: Audio File
C:\Skills101'marks.doc

o

File Paths: Drive Name Folder name File Name

Renaming Files and Folders
Right click on the file or folder->Rename (or press F2)

Deleting Files and Folders
= Temporary Deletion: Right-click the file or folder, and then click Delete.
= Permanent Deletion: SHIFT + delete.

Restoring Deleted Files
Right click on the file or folder—-> Restore

Folder and File Attributes
Right click on the file or folder-> Select Properties

Part V : Shutting Down or Logging off a Computer

v

v

v

Log Off: Means that you log off as a User without turning the computer off. Someone else
can then log on.

Shut Down: Means that you log off as a User and the computer is turned off at the same
time. You will lose any unsaved information's.

Restarting your Computer: Restarting your computer means that the computer logs you
off to system, turns itself off and turns itself back on again so you can re-log on

Sleep — Documents, applications, and the state of the operating system are saved in RAM.
This allows the computer to power on quickly, but uses power to retain the information in
RAM.

Hibernate — Documents, applications, and the state of the operating system are saved to a
temporary file on the hard drive. With this option, the computer takes a little longer to power
on than the Sleep state, but does not use any power to retain the information on the hard
drive.
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LAB.1 : Windows 7

Comprehensive Task:

|

. Create a folder named (collection) on the C drive

2. Create two subfolders inside the above folder, with names (images) and (data)

3. Open Microsoft word then insert some objects [clipart, table, pictures, and
paragraphs] on it then save it in the subfolder (data)

4. Open Microsoft excel then insert some data then save the file in the subfolder (data)

5. Open Microsoft PowerPoint then insert some shapes or pictures then save
the file in the subfolder (data)

6. Delete the word file, where did it go? Can you restore it? Where was it
restored?

7. Search your computer for pictures of type (jpg), choose 3 of the search
results then save them on the folder (images).

8. Open the picture in paint program [using open with option] then save it in
other formats: gif, bmp and png.

9. View the files in the subfolder (images) in details view then arrange the files
according to size in descending order.

10. View the files in the subfolder (data) in list view then arrange the files
according to name

11. Find the size of the folder (collection), then compress it [using WinZip or
WIinRAR] and check the size again. What do you notice?

12. Change the icon shape for the folder (collection).

13. Create a shortcut for the folder (collection) on the desktop.
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LAB.3 : Getting Started with Word2010

Part | : Introduction to Word 2010 Environment

Quick Access Toolbar File Name.docx Minimize - Maximize - Close

Home Insert Page Layout References Mailings Review View == Tabs Q ”

e

‘ j 4 Calibri (Body) vl v =ity | EEE & % i)
- m == = A=
Ga | B 7 U-abex, ¥ | B |=E|=E =E=-| 1=
l

Paste . o= ¥ oy Quick Change  Editing
v v F| B PSTA A | A E“ S-He| 2|9 Styles ~ Styles ~ v

Clipboard 5 | K f Font‘ = Paragraph Styles
frpt et | )“ ? —
e e he Some groups have -
Groups an arrow for more

options

Insertion Point
" 7/ | e
HE : 2
; Views: Current Zoom Button
Page # of Words S o
# Pages  Count view is highlighted Zoom Slider B
A XA X | _ 2 0
Page:30f 5 | Words:0 | 5 English (US) | Status Bar Bag = =] 120 (<) 0 *® .

Part Il : The Quick Access Toolbar

You can add other commands to make it more convenient for you
Task: Add the following commands: Quick Print and Save as to Quick Access Toolbar

Task: Delete the above commands from Quick Access Toolbar

Part Il : Creating new file

Task:
using templates, Create 2 new files: one contains a design for a certificate, and another one
contains brochure

Task: create a blank file.
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LAB.3 : Getting Started with Word2010

Part IV : Home Tab
Clipboard Group

Task Use the blank file you’ve created in the above task to do the following:

Select a paragraph from the skills PDF book then copy it.

Paste the copied paragraph on your file.

Select a word inside the pasted paragraph, and then move it to a new line.

Format a word inside the paragraph [Hint: use the group font], and then copy the format
to another word.

Font Group

Task

Write (Balgaa Applied University) in Arial font, of size 16.

Try the bold, italic and underline commands on the above sentence.

Write the following: H,O and 25°C using superscript and subscript.

Try strikethrough, text effects, highlight and font color on words from the paragraph in
the previous task.

Write (bALgAa aPPLIEd uNIVERSsIiTY), then try the cases from change case on it.

Paragraph Group

Task

Write an English paragraph about your country where you live (at least 3 lines), make
sure that the direction is left to right and the alignment is left before start; put a border
around special word(s) in the paragraph.

Write an Arabic paragraph about your specialty (at least 3 lines), make sure that the
direction is right to left and the alignment is right before start, color (shading) a special
word(s) in the paragraph.

Justify both paragraphs.

Make the line spacing 1.5 for the English paragraph and 1.15 for the Arabic paragraph.
Write a bulleted list for 3 countries then add some of their famous cities (multilevel list).
Write a numeric list for your everyday activities (multilevel list).
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LAB.3 : Getting Started with Word2010

Task

direction is ) S sladl (o SU 4 Gt 2 il (o Lggd Gaaati Sland ¥ e J8 Y & alail 5 % (il
& 5 mes e U (borders) 1asas s AUSIL ol Jd (alignment is left) 81l 5 (left to right
V.0 = (line spacing) b aels Jasl b il

direction is ) LU oladl (ya 38 s a5 (N Hhaiads (o L Gaaati Hlaud ¥ e J8 Y 4y e 58 il -
2 3 IS X (shading) o <l A1 2l Jé (alignment s right) 313wl (right to left
Y, + = (line spacing) _haw¥! aels Jaal 3 jdll

Ol o jall (e 38 (justify) Lua) -

ALY Ao Lgiae (e pans )83 e Ll a8 (Al laldl e &D6 (bulleted list) (s sty <3 -
.(increase indent

[(increase indent paaiul) e A&l Jee W) Gz S5 ae e sill elllae ) (numeric list) (<8 dlaxiy <3 -

Styles Group

Task
- Try Elegant Style or Formal Style for your document.

Editing Group

Task
- Find a word in your document.

- Replace a word by another one.

Comprehensive Task

Open Microsoft word, type the following data:

Today is Sunday 16/10/20186, this is AUTUMN. The temperature is 21°C, the weather is fine.

This is SIllE 0L [ab. We will take 2 exams as the following:

1. Mid Exam:
o Windows

o Word
2. Final Exam:
i. Excel

ii. PowerPoint

iii. Internet
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LAB.4 : Word2010 (insert Tab)

Part | : Insert Tab Groups

Pages Group

Task Copy a paragraph from Skills Book on a blank page, then do the following:
- Insert a cover page (<> 4sa.2) for the document.
- Insert a blank page (4¢_ 4~i2) after the cover page.
- Insert a page break <isia Juald)) inside the paragraph in the 3" page.

Tables Group

Task
- Insert atable (3 cols (3x«=1) & 2 rows(—s2=) ), then fill it with data.
- Notice the two additional tabs that appeared:
o Design Tab: Color some cells (shading), Add new borders (Try to draw diagonal
borders), Delete some borders, Use styles group to get more professional designs.
o Layout Tab: Add/Delete rows and cols, merge/split cells, split table, align text in
cells and check text direction within the cells.

Task

Write the following data:
First,Second, Third
A,B,C,D
11,23,14
Select the above text then click on tables - Convert text to columns.
In separate text at option choose comma then click ok.

llustrations Group

Task

- Insert a picture (3, s=), from the Design Tab appeared: Remove Background, add frame,
move the picture (using wrap text) and crop the picture.

- Insert a ClipArt ()5S )\S 3, ), from the Design Tab appeared: Add frame, move the
clipart (using wrap text), rotate the clipart and crop the picture.

- Insert a Shape (JS%), from the Design Tab appeared: Change the style (Fill, Outline and
effects). Add Text inside the shape (change text direction), rotate the shape and change
the shape to another one.

- Insert a SmartArt (S3 = )) (e.g. Water cycle) from the following Tabs appeared:

o Design Tab: Change: Layout, Colors and Styles.
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LAB.4 : Word2010 (insert Tab)

o Format Tab: Change the Shape Style and WordArt Style (Fill, Outline and
effects)...
- Insert a Screenshot from Skills book, and a Screen Clipping from the desktop.

Header & Footer Group

Task
- Insert a header (*~iall Ul ) that includes: your name, date and time.
- Insert a footer (sl JuX) that includes page number and a picture,

Text Group
Task
- Insert a text box (u= Bs1=) contains the word (Skills), from Format tab change: shape
& text (Fill, outline and format), text direction and change the shape.
- Insert a WordArt (42 4.1S) contains the word (Balgaa Applied University), from Format
tab change: shape & text (Fill, outline and format), text direction and change the shape.

Symbols Group

Task
- Write area of the circle.

- Insert the following equations:
U 1
J L
8] 3 T x
) x 1ifx=0
()=

=x.1fx<
r,
l+@" Cr,

Lp=r+
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LAB.4 : Word2010 (insert Tab)

Comprehensive Task
(Y Jars o8 5 Word dase s 38
tﬂﬁgﬁ‘j MJ Lﬂm\ L_\ﬁ\ -
éy‘ djﬁéj\ GJJ\ -

.(Blank Page) 4& & daia # )3l o8 daulidl) il o3l 5 (Cover Page) zo2 -

Aaide @l iy o) a5 el (5 sing 4ani (Shape) Sz o) -

2k Ul a5 (Picture) 3 s z o -

el o 3 530 8 o(ClipArt) o) -

ol s CLIS (e 40 Sall Aadlall(SmartArt) z 3 -

Sl e e £ 321 (screen clipping) des) -

<8315 05l &5 c(header) 4 e -

BSypasdasall 8 (footer) &2z -

OV et ae alia AN JSS ) JSAN e & dlaiadd 48 o ((textbox) oY -
Ll

(WordArt) alaaiul jiee (uld) (i€ -

e s Javie jia ¢l (JalSi e (5 5iad (Equation) 4l Aalae aiS) -
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LAB.5 : Word2010 (Page Layout, References & review tabs)

Part | : Page Layout Tab

Themes Group

Taskl: Copy a paragraph from Skills Book on a blank page, and then do the following:
- Apply one of the Built-in themes appeared in Themes command.
- Customize a new theme by choosing Colors, Fonts and Effects available in the group.

Page Setup Group

Task2:
- Change the margins of your document from Normal to Narrow, then to Wide, what do
you notice?
- Change the document Orientation in to Landscape (Horizontal Page).
- Split text in a page into 2 columns, 3 in another page.

Page Background Group

Taska3:
- Add a Watermark to your document: your name in a diagonal layout.
- Change the Page Color.
- Add a Page Border to the document, choose from Style the line layout you want, or
choose from Art for more options.

Part Il : References Tab

Table of contents Group

Task4:
- Choose one of the Built-in Table of Contents appeared in Table of Contents command.
- Or press on insert Table of Contents from the menu in Table of Contents command.

Footnotes Group

Taskb:
- Insert a verse from the Qur'an, and then refer to it as a Footnote.
- Insert a line of poetry, and then refer to the poet and the poem as a Footnote.

- Insert a quotation, and then put on a Footnote who said it.
- Copy a paragraph from skills book, and then refer to the book in the Endnote.
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LAB.5 : Word2010 (Page Layout, References & review tabs)

Part Il : Preview Tab

Proofing Group

Task6:
- Press on Spelling & Grammar command, and correct the errors appeared in your
document:
o Spelling Errors: underlined with a red wavy line.
o Grammar Errors: underlined with a green wavy line.
- Also try the right-click mouse options on errors.

Part IV : Auto correction options
Task7:
- Add the word (blga) to the Auto correct options to be corrected into: Balgaa Applied
University.
- Add the word (bal) to the Auto correct options to be corrected into: AL-Balgaa Applied
University.

Comprehensive Tasks
fst Lo ey ad s Word s o =) =)

.(Landscape) 8! ) dsdall olail Joa

A e g s se ) (B (Lol T e JEY) 38 i)

g sasall dalin s ) a3l

Legall 3 LY ae (Lsile U8 5l mdll (e ety 13 Canam KU (1A () (il S
Ao saill 5 Y cUadY) (e il maia S5 ¢ (Foot note) dadall Jaul ddasdla

.(End note) <l dlgs (8 dlaaDley 43l ) &5 (QUS ) 5 58I a8 ge (e B 38 Gl O

AUS 2 (nnn) el 48lials o8 (Auto correct options) (Sl msaatll Gl jla aladiuly 1

Lol el clew)

bl dlasal (Water mark) 4k AlaS claud N

(Two columns) (pa e J dsdall L3 A

ladiall J g Uadia | Ul s

—

L S &

D
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LAB.5 : Word2010 (Page Layout, References & review tabs)
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LAB.6 : Excel2010 (Introduction)

Part | : Introduction to Excel 2010 Environment

Quick Access Toolbar File name.xlsx Minimize — Maximize - Close

Q X

(6] PR estadsX | Microsoft Exc el

Insert  Pagelayout  Formulss  Data  Review . Tabs o @ o 9K

File Home

% Catbn TR ey - Genent - A Gelasen -
;’e-uv BZ U- AA EFEF N $ % » s':“ 3% Delete ~ jslzﬁ
ste s 2 o n
g B-iS-A- R - - W [E)Format = (2~ Fiter~ Select~
Chipboard  1a Font w Alignment v Number . (cm Eguti nq
| os v (® 5 &
AN B c_|™DP™. £ \r
1 Name Box F
2 Formula Bar G"OUPS
3 €——Row Numbers .
S Column Letters
5| > |
6
7 Active Cell
8
9
Worksheets (3 sheets by default) ' Zoom Button
| : Views | Zoom Slider ~
| 4 < » ] Sheetl ~Sheet2 ~Sheet3] ¢J 0 KA : »D
| Roty | — (8 3 21 100% (=) ¥
Right-click the worksheet:
Insent.. ====P (1) Adda new worksheet
Ud Detete e (5) Delete the worksheet
Bename s (3) Rename the worksheet
Move or Copy... wmmelp (4) Move or Copy Worksheet
Qd  View Code
&)y Protect Sheet...
Tab Color '-—)@ Color worksheet tabs to help organize your worksheets
Hide

Select All Sheets ¢
Sheet r sirewwromeews __‘

Task Try the previous right-click options (from 1 to 5) on a new worksheet.

BB 40 D ¥

Task Select the following ranges:
(1) B2:B9 (Vertical Range) (2) E2:J2 (Horizontal Range) (3) D4:F7 (Block Range)
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LAB.6 : Excel2010 (Introduction)

Task: Select a cell then enter:
Ctrl + ; > what’s the contents of the cell?

Ctrl+ : > what’s the contents of the cell?
Using the Fill Handle to Fill Cells

Task: Apply (1) then (2), try to find out the result of filling cells in (3), (4) and (5).

1 1 1 Januaryf Sunday
2 2 3
3
4
5 v v v
] © @ ®
7
8
9
10
® @
A
1 0| 1 |a
2 5/ 2 B
3 3
4 4
5 5
6 6
Task: What will be the contents in the cell A5? 7 i

Part Il : Home Tab

Clipboard Group
A B C

1 numl fun
2 5
3 8
4 6
4

5
'I:ask Print the following data:
- Copy A3 contents to C2.

- Move contents of C2 to C4

- In B3 write the formula; =A2+A3.
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LAB.6 : Excel2010 (Introduction)

- Copy the result in B3 then paste it on B4. What do you notice?
- Copy the result in B3 then paste it on B5 using one of the paste options (values). What do
you notice?

Font Group

Task Start typing from A1, the following data:

A B
Name Mark 1
Sami 78 2 |Sami 78
Kareem 81 SR 3 |Kareem 81
Ahmad 92 be as the following: 4 |ahmad 92
Yazan 45 5 |Yazan 45

Alignment Group

Task Add the following changes to the previous task, Notice that:
Cells A1 & B1 are merged in one cell (by Merge & Center option).
Cell C2 is formatted by: Wrap Text option.
Cells A2 & B2 are formatted to aligned in center & middle.
A B C
1 Students Marks

Final
Marks

G s W N

Merge & Center the cells C3:C6
Write inside the merged cells (Students Results) in 90° orientation text.

Computer Skills Lab Page 4 By: Islah K. Gharaibeh



http://holowczak.com/getting-started-with-microsoft-visual-studio-2010-using-c-tutorial/

LAB.6 : Excel2010 (Introduction)

|| b1 - 5i  General
Angle Counterclockwise

Angle Clockwise

Lir

% T b e Y

Vertical Text
Rotate Text Up
Rotate Text Down

Format Cell Alignment

[Hint: use the command ]

A B C
Students Marks

oo B WN

Number Group (Format Cells dialog box)
1- Number Tab
Write the number 1.9438, use Number Tab in Format cells dialog box:
Choose Number from Category, then:
- Let the decimal places = 3, what do you notice?
- Let the decimal places = 1, what do you notice?
- Let the decimal places = 0, what do you notice?
Choose currency from Category, and then choose ($).

2- Alignment Tab :

A B

N ©

%\‘: o

1 S° ]
this is
2 atext

3 shrinking a text

4 another text

3- Font Tab
4- Border Tab
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LAB.6 : Excel2010 (Introduction)

5- Fill Tab

Styles Group
design tab

Cells Group

= s—e e
@ cmm TX gl @

To insert ~ = S To delete
cells, rows T [nset Delete Format = co|ls rows
or columns o or columns
Insert Rows
Insert Columns
Delete Rows

Delete Columns
Modify Column Width

Comprehensive Task
redtll) Cua (e SV Calall 4l Cala Jany o8 5 Excel dusa o i)

A B C
1 Obadll g 4S) gall jlad
e | sl
3 S5 $1.15 $1.27
4| s | s155 | s163 |
5 | Jau | s090 | $1.05 |
6 | @5 | s267 [ s276
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LAB.7 : Excel2010 (Insert Tab & Simple Formulas)

Part | : Review

Task: As you learned in word, using the insert tab, insert the following:

1- A picture (choose one of the pictures in pictures library Jall S3alll ) sall e gl i),

2- A clipart (e.g. books).

3- A star shape dea3 JS3 (Write your name inside it) add some effects <l il sz Caual
(outline, shadow, glow ... etc.).

4- A smart art that describes the hierarchy of the university (2 slud¥) s CLISH Cua (e daalall 4lSoa
e S).

5- A screen shot (from desktop or the material <iSall mha sl salall (30 L3I 5 ) sua),

6- A text box contains (Excel 2010) than change the shape (LAl JS& I J& 5e) and add some
effects.

7- A word Art contains your specialty (e aul),

Part Il : Insert Tab

Charts Group
Task: Using Excel do the following:

In sheetl In sheet2 In sheet3
Name Mark X F(x) Item p
Jameel 75 0 0 A 5
Sami 35 2 4 B 25
Khaled 67 5 25 C 12
Osamah 90 10 100 D 33
Talal 47 E 25
Ahmad 85

» Select the table in sheetl, and then insert a column chart for the data.

» Select again the table in sheetl, then insert a bar chart for the data.

» Select the f(x) column in sheet2, and then insert a line chart for the data.
» Select the table in sheet3, and then insert a pie chart for the data.

Use the following additional tabs that appear after inserting the charts: Design, Format and
Layout

Text Group

Task Insert a header & footer:
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LAB.7 : Excel2010 (Insert Tab & Simple Formulas)

In header: write your name in the left, “Computer Skills” in the center and insert time in the

right.

In footer: insert a picture in the left, “Good Luck” in the center and insert page number in the

right.

Part lll : Simple Formulas
Mathematical Operations:

Task: Write the following data (start from cell Al):

X
5
Then write the following:
X+y=
X-y=
x*y= Use cell references
x/y= to calculate:
xNy=

Evrors in Excel:

X+y=
X-y=

x*y=| 10
x/y=| 2.5
xAy= 25

#H#H#HH#HA: The contents of the cell cannot be displayed correctly because the column is too

narrow.

#REF! : A cell reference is invalid. This is often displayed when you delete cells that are

involved in a formula.

#NAME? : Excel does not recognize text contained within a formula

Editing cell content:
Task: Edit the cell below by adding the letter d.

abc

Ovder of Operations (Priorities):
1. Operations enclosed in parentheses
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LAB.7 : Excel2010 (Insert Tab & Simple Formulas)

2. Exponential calculations (to the power of)
3. Multiplication and division, from left to right.
4. Addition and subtraction, from left to right.

Task: Calculate the answer of the following formula [=4*3+18/(5+4)-2"3]

Absolute References

Task: Use the data in sheetl you’ve previously created, and do the following:

New New

Name Mark Mark Name Mark Mark
Jameel 75 Jameel 75
Sami 35 Sami 35
Khaled 67 Use the absolute Khaled 67
Osamah | 90 cell reference to Osamah | 90
Talal 47 calculate new mark: Talal 47
Ahmad 85 Ahmad 85

[Bonus | 3 | | |Bonus | 3 | |

Comprehensive Task
(AUl bl e JSY Ay pazall aan) waall el sl 5 Excel A 38

Hint: New Price = Price + Price * Tax

Item Price [P\Ir?:;/\(le

shirt 9.5

T-Shirt 5.25
Suit 120.5
Socks 1.85
Shoes 16.75
Belt 4.25
Tax 0.06
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LAB.8 : Excel2010 (Advanced Formulas)

Part | : Working with Basic Functions
A function is a predefined formula that performs calculations using specific values in a

particular order.

Excel basic functions:
» SUM : returns the sum of cells in a range.

1

2
2
3

4

5
6
7
8

Adding cells to the function argument

A 8
Name . Mark
Qasem‘;r 76 ;
Ahmad{ 84 f
Sami | 35 |
Zad | 90 |
Fares ; 40 é
Nader | 76 !

Total |=SUM(8?:B‘/

¢

A 8
1 Name Mark
2 Qasem 76 ‘
3 Ahmad 84 =SUM(B2:B7)
4 Sami 35 Equal Function Argument(s)
5 Zaid 90 Sign  Name
6 Fares 40
7 Nader 76
8 Total 401 '

Result Syntax of a basic function

» AVERAGE : returns the average of cells in a range.
» MIN : returns the smallest number in a set of values.
» MAX : returns the largest value in a set of values.

» Count:

Task: Insert the following data:

o
CJ"@ -

F) il fine Lo (SCOUNT(AL:C3)) dlabadl i de Ja s b

» ROUND : Rounds a number to a specified number of digits. ROUND(number,num_digits)

Task:

eial) ol fine G L
eial) il fine G L
eial) il fine G L
eial) cl fine G L

AN N N N
1

& ((EL) sl & (), Ve vos) Jul L) i)

Aaladl) ) (E2) Ll 9
Aalaal) iS) (EZ) ads 8
Udlaall i€ (E4) s b
skadll ) (E5) s B

=ROUND(E1,2)
ROUND(E1,3)
ROUND(EL,1)
=ROUND(EL,0)

1
© O O O

N N S’ S
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LAB.8 : Excel2010 (Advanced Formulas)

> |F : returns one value if a condition is TRUE, and another value if that condition is FALSE
IF(logical_test, [value_if true],

[value_if false]) e futon @y el
Q@ . XV & . oI
= = s t KD_ O welest » prtegrys Logead :J |
1 Name Mark Result ”—"”"“‘""“"""’Z:M : “
2 Qasem 76 :l EAS ‘
y Ahmad 84 ;«;““
) ] a Sami 35 e
Task: in D2 write the formula - zaia 90 Wmmmﬁwu b
=IF(C2>=80; C2+3; C2+5), fill *©fares 40 e — |
7 Nader 76 i L el
to cell D7. ey ]

Name Mark Result F
| togical_test 52550

Qasem 76 |Pass « Vo £ 3e | Deas’
Ahmad 84 |Pass | WA et ol

Sami 35 |Fail | Checks whether 3 condition is met, and resems one valkoe f TRUE, and anather wsus i TALSE
‘ Value_# false & the vae that s retumed f Logicl_test o FALSE. If omtnes, FALSE
| K relumed

- Mg
- Tam"
- v ‘

(2 ) 2|

Zaid 90 |Pass ,
Fares 40 |Fail 1w..,. fon |
Nader 76 |Pass | ot ) Lo |
Function Library Group
Formulas

£ T 0BG A 6 @

Insert AutoSum Recently Financial Logical Text Date& Lookup & Math More

Function v Used ~ v v v Time v Reference ¥ & Trig ¥ Functions 3,
\ Function Library ¥
D You may search and select Excel
Sum
Lot youasanch |= @ functions based on categories

for your desired | Average
function (or use | count Numbers
the command & |,

in Formula Bar) |, @ Allows you to automatically return the results for
@ More Euchions... a range of cells for common functions

Part Il : Data Tab
@ Ascending Sort €= ,
@Descending Sort 4= b Re
7
@ Custom Sort 4 _ X7 Advanced
Sort & Filter
@ Filter Data 4 /

Computer Skills Lab Page 3 By: Islah K. Gharaibeh
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LAB.8 : Excel2010 (Advanced Formulas)

Sorting data

Custom Sort (sorting multiple levels)

A

Name
Qasem
Ahmad
Sami
Zaid
Fares

A . B A . B

1 [Name Mark 1l 1 [IName Mark
2 |Ahmad 84 ' 2 |Zaid 90
3 |Fares 40 3 |Sami 35
== Click the ==

74” Nader 76 descending 4” Qasem 76
s [Qasem 76 | commandto g inader 76
| Bt g sortnames —

6 |Sami 35 fromZto A 6 |Fares 40
7 |Zaid 90 | 7 |Ahmad 84

Task: What name will be inA6 if the sort is ascending?

B = ) | < A 8
Mark s atvet | (X piemient ] [aperies =1 ~ [[omemsds || [2|Name SiVIGTK
76 Colam Sert On Order 2 |Sami 35
84 e il T 3 [Fares 40
35 4 |Qasem 76
90 ‘ - — ~ s [Nader 76
40 Click the Custom Sort command to s |IAhmad 84
76 sort by Mark then by Name > |zaid 90

~N (e e . wN e

Nader

Task: What name will be inA4 if you sort by mark smallest to largest then by name A to Z?

Filter Data

A B A B —
[m] (Select All)
1 Name Mark T 1 Name [~|Mar{~ | O3
L 140
2 Qasem 76 ‘“"”’ 2 Qasem 76 w76
: Ahmad 84 ¥ %53 Ahmad 84 o
5 iC e .
a Sami 35 Filter 4 Sami 35 e A—
s Zaid 90 command 5 Zaid 90 1 Name [~ Mark ¥
to filter the 3
6 Fares 40 dats 6 Fares 40 2 Qasem 76
7 Nader 76 7 Nader 76 7 Nader 76
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LAB.8 : Excel2010 (Advanced Formulas)

Text to Columns

A B C = Convert Text to Columns Wizard - Step 1 of 3 (L2 s

1 Name; Mark; Address B e e e e st o
2 Qasem; 76; Amman conmr: | e
3 Ahmad; 84; Zarqaa ‘ ’ e
4 Sami; 35; Agaba fimsbentoties

: Click to || [ vame: saseems .
5 Zaid; 90; Amman separate Eg,xss:‘“ ‘
6 Fares; 40; Zargaa cell L s
7 Nader; 76; Irbid czzfﬁr,‘,’:zsto == T

A B C Comert et Cauney W Siep 3 3 (-2 | Convert Tt 1 Columns Waard - Stp 2043 L S |
1 Name Mark Address ‘%xmmm:*::&am“m xjf'wmmmmmmmmmmn
2 Qasem 76 Amman e (W& s e

Do ot frport cokem (549) o &l

3 Ahmad 84 Zarqaa = —*; - Select the delimiter
4 Sami 35 Agaba : - (semicolon)
5 Zaid 90 Amman I :: g = , |
6 Fares 40 Zargaa )~ P e e x|
7 Nader 76 Irbid cme. [l P o] ) () B

Part Il : Review Tab (Adding a Comment)

Name Mark

Qasem 76 ;:{J »
Ahmad 84 Comment
sami [35 Ty @
Zaid 90

Fares 40

Nader 76

Part Il : Using Templates
Excel allows you to create a new workbook using a template, which is a pre-designed
spreadsheet, To Create a New Workbook Using a Template: click New from the File tab, and
then click Sample templates to choose a built-in template, or select an Office.com template

category

Ahmad
Sami

84
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LAB.8 : Excel2010 (Advanced Formulas)

Comprehensive Task
:Jaal s (Excel) dama s il

:‘EACJ\ Jeaall v

Mark Name (Sum)olsBY) alaaiuly Colall ledle ¢ sane cawal -
Jamal 9 (Average) o) &Y aladinly Gl Gldle Jare sl -
Ali 12 (Max) ¢lsEY) aladinl MLl ddle Jlef caual -
Saleem 5 (Min) OB alasiuly COdall 4adle ol cawal) -
Hani 18 e (551 Aldlae & 3 SI 5 (Result) Ol st 1 1 see ol -

11 « 10 ng\.uu o) S daDlad) CilS A, Pass c_\Lu TN |f) idas

10 (e J8 MM\ g_ulS Ky, (Fail) Q"‘L"' S

(|f) daa e S S 5 adalaa 408 S g (New Mark) O s \A.m; 12 gac Cacal-
)\UALJS\MM‘Q—U\S 131 Lol ZLSJ@?:‘].].UA)%S“\-‘M\ u_uIS\J\c_\:\;.)

3l e 11 b,

Kamel

AU Jsaall v
Mark Name
Rami 58
Laith 70
Zaki 44
Jehad 82
Zaid 93
Ahmad 90
Rayan 44

Laeliat OOl eland ava ) Joaall (555 -

T GOl eland s Gl Jsaall iy -

e 55 Ay sbate Ciladladl oans i€ 131 hae las GOl ciladle caa Giladl Jgaall iy -
.(Hint: Use Add Level) W sl asy)

L 100-80 (pana iladle 155 5n) Gl (DUl (mje Sy Guny i) Jsaal) il -
Aid 7aid Al Gldle (el Gl jalall aladsnly
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LAB.9 : PowePoint2010 (Introduction)

Part | : Introduction to PowerPoint 2010 Environment

Quick Access Toolbar File Name.pptx Minimize — Maximize - Close
A\
=

university § Micros o 2

e e S e S AL = G A )

B = o AN sz EEe I %, |88
Hay B Bl e 7N (s

S 4 [ B L U & abe AV~ Aa-|| A~ | E E = BE- »y ¢ BE~ B Shapes Amange Quick — | Editing

i v Styles~ ="~
| Clipboard 1%

Slides Font

Paragraph

Slide Pane

Of
‘i’ _y/nsertion Point i1 . Il
1
&

oy
L=

Click to add subtitle

Placeholders

|
Page #
TR

# of Pages

>

Notes Pane Click to add notes g

Normal Reading Slide Sorter Slide
View View View Show

Task Write your name and your city on the 1% slide (s dag yill e @linae anl 5 claul i),

Part Il : Home Tab
Slides Group

bl o) Al a5 ol Al dagdad (et Bale) 5 i s ol i) A8l (e Ao sanall 028 Gl

l:l & Layout ~

@ Reset
New

‘ slide - = Section ~ ';]534

Slides
New

Task Add a new slide to your presentation (use: Ctrl+M OR click Home Tab—>Slides—> == ")
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LAB.49 : PowePoint2010 (Introduction)

Task:

2 il i A Qi) yh Y ALl o8 Click to add title

‘et JS1 331 (Layout)
(picture) z 3 -
.(clipart) z 3 -

szl - }

e JSI wiSla i quns e

* Click to add text

4=} Placeholders

Icons to insert
different types
of content

Task Insert a picture to the new slide, write a title and write text.

=} Layout -
Office Theme

To Change the Layout of an Existing Slide:

1. Select the slide you wish to change.

2. Click Home tab - Slides group - Layout.

3. Choose a layout from the menu. The slide will change e
in the presentation.

Task:

Lo JSI DLl ol il daglads jia) o5 il i ¥ ddlialy o | e Conten

Bosa gy pe (e g mage B bl Y oge Jo Y L) -
et ) sie

ke ol sic aua s & (picture) s (clipart) zod -

i )i dagpd -

Part Il : Insert Tab

“

Title and Content section Header

Comparison Title Only

Content with Picture with
Caption Caption

«(ClipArt) s« «(Picture) 5, 5= «(Table) dsi 713 Ly dliSay (Excel) 5 (Word) 8 il < )2 LS
s Ll ) ((Chart) e sy «(SmartArt) oS3 as ) «(Shapes) JSal «(Screenshots) 4alill (e 3 sa
Ao gane DA (o il il Jpa adaie 5l a2 ) (B Lo gea ) Al iy 43l Y &) ((Hyperlink)

(o%e ]
Video Audio

Medl.a GVOMP Media

Task:

.(Media Group)

el Lalial ) i) il 5 g adalia g sy adaie Adlical, o8
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LAB.q : PowePoint2010 (Introduction)

Two additional tabs will be available when adding a video or an audio:

Format Tab:

Aayl aaxi o(Styles) < il ans s gpadll Ul yusd ((Adjust) sl selaal s o ) Jasa e Jaaaill (g0 iy

Playback Tab:

r I () Y
Trim Video = “
Wdife. wiw Durstion: 00:02.412

(Size) sl

Jarns Lakaia m yaal (Trim Video) ssusll e li€a

Task:
IR (e Wl aia ol (53 gl paba e Jyailly o
(Playback Tab) JMa (s 4.8 &3 ¢(Format Tab)
OIS Y Osan Y lakia (i 2l

00:02.699
00:00.287 = \ " 00:02.696 =
' 4 ‘
Start Time ! End Time
ox. | |

Cancel

Part IV : Design Tab
Themes & Background Groups

Animations

ol Bl = T

Themes

Transitions

AaI

Insert Design Slide Show Review View

Aa

L L)

= |

L L L

Create a background of your own by selecting Format
Background. The Format Background window will appear
and allow you to select the color, gradient, picture or texture,
and transparency of the slide background.

Adlise ) ga ol Talail 5 ol ol 0l Al s ) 61

Task: alide Jaciy ¢ o Leia JS ALl mil il il )

Format Backgrounde

)

Pcture Conecons

Pcture Color

| —
Fil - Format

o Sodm
Fadent 8
sarowaren Background
Patien Al

ude bodgrand gaches W indow

F Coler
Color: | O v |

Traceparercy: 1) 0% B

Close [ aopyom
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LAB.49 : PowePoint2010 (Introduction)

Comprehensive Task

i Ol sie 53 ) gem pn g qa (re & e b bl Tge o Y Le S AN dag Hdd)

AUl =80 il oLl &8 5 (PowerPoint) dass  ziél v/

Sl S g el iS) 1 g Aagpll) e

A0k O sie s aa (clipart) z ool (AN dag pddl e
O sie gy ae Juaiall Glakie i el dialy a5 g ol rdag) ) dagpdl) .

Ol sie gy an dxalall a8 ga I Jii adde Laaall die ((hyperlink) i) & ) Al dag il .

ol alagl 2ny (Excel) oo Il Jsaad) JEil &3 (Students Marks) O sie g tdwdlad) dag pdldl - o

Name Mark
Jamal 9
Ali 12
Saleem 5
Hani 18
Kamel 11

4y sllaall

Adkll Gl (max) s (min) «(average) ¢ (sum) 4wl sl Jas)

O i) a1 JEl &5 oBled Jsaadl 8 anllall iladle Jia 43l o ge I aa) aladiinly rdaglud) dag pdldl o
Ay il () an ) () sie pua g saall agiadle pe @l slan) Jiay 521 (Excel)

i Tass 5 5 gt IS BRI 21 SIS )

Computer Skills Lab

Page 5

By: Islah K. Gharaibeh



http://holowczak.com/getting-started-with-microsoft-visual-studio-2010-using-c-tutorial/

adiualiclalll acals

AL-BALOA'APPLIED UNIVERSITY

Computer Skills Labs
Lab.10

PowerPoint2010

(Advanced)

Prepared by: Islah K. Gharaibeh

2019/2020



http://holowczak.com/getting-started-with-microsoft-visual-studio-2010-using-c-tutorial/

LAB.q : PowePoint2010 (Advanced)
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Part Il : Animations Tab

’ Home Insert Design Transitions Animations Slide Show Review View Format
Y T .
A c% >0 Animation Pane
< ) -
-( )‘ \7 K Lo A T >
o A
None Appear Fade Fly In Float In Split < ’ “dc_f L P
Animation ¥
Animation [ Advanced Animation Tnnmg

dlieall Ul (Entrance) Jsaall s n Hladl) kg
PR (EmphaS|S) ;M\ C'.\LS);} cc\‘)ﬁaﬂ\ ej;.\ﬂ_l
e}&.ﬂb aliaall (EX|t) '&)JU;AM Q\SPJ cc\‘)s..aj\ e);.\ﬂ_l

c{%énimation Pane

Add

Animatiqn -

Entrance

~ Reorder Anima

i 4

AP < 3

- r
A y‘ L0 b A
Appear Fade Fly In Float In Split
~ W . ¢ = ,
Wipe Shape Wheel Random Bars  Grow & Turn
e R
Zoom Swivel Bounce

sl saaa @lS ja e deand G (More Entrance Effects) (e bl cliSay <ilS jall (e jall Ll

r.l':'ldd Entrance Effect I. ? ﬂhr
Basic =
(% Appear | 3k sinds Once the animation has been applied, you can click
S Box S Checkerboard on the Animation Pane tool to customize the
S Circe Sk Diamond applied animation in terms of timing, triggers for
¥ Dissolve In Frymn = the animation.
X Peekin X Plus B Start: On Click * Reorder Animation
X Random Bars P split © Duration: 0100 %
Hr Strips Hr Wedge @ Delay: 0000 2
e Wheel e Wipe Timing
Subtle T .
n .
ﬂExpand * Fade L g GVOMP
.fSwiveI fzcu:.m liall Oe Y sl 25)3 ed i (e :\-‘;}“‘3‘“}\ AL PEILON
Moderate SliCat LS cdaa o) (Balaal) (PIKT) 2y Lolals 4S5l ) gl e
f Basic Zoom f Center Revolve 25); @)MS) L@th" 5‘ (UJ\S]\ I“SP ;L.fk'a) ‘\S);“ Ba BJITU. oo
#¥ Float Down #¥ Float Up i (UJLSM
Preview Effect [ Ok ] [ Cancel ]
Computer Skills Lab Page 3 By: Islah K. Gharaibeh



http://holowczak.com/getting-started-with-microsoft-visual-studio-2010-using-c-tutorial/

LAB.9 : PowePoint2010 (Advanced)

Part Il : Slide Show Tab
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Comprehensive Task
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LAB.9 : Internet and Computer Networks

Part | : What is a Network?

A network consists of two or more computers that are linked in order to share programs, resources (such as
printers), exchange files, or allow electronic communications. The computers on a network may be linked
through cables, telephone lines, radio waves, satellites, or infrared light beams.

Common types of networks include:

e Local Area Network (LAN)

e Wide Area Network (WAN)

e Wireless LAN (WLAN)

e Metropolitan Area Networks (MAN)
e Wireless WAN (WWAN)

1.1. Local Area Network

A Local Area Network (LAN) is a network that is confined to a relatively small area. It is generally limited to a
geographic area such as a writing lab, school, or building.

1.2. Wireless Local Area Network

The term ‘wireless network' refers to two or more computers communicating using standard
network rules or protocols, but without the use of cabling to connect the computers together.
Instead, the computers use wireless radio signals to send information from one to the other. A
wireless local area network (WLAN) consists of two key components:

e A wireless access point (WAP) (also called a Base station)

e And awireless card. \

Wircless Access point or Wircless Basestation

=
WiFi Wi-Fi is a popular technology that allows an electronic device to exchange data or connect to the internet

wirelessly using radio waves.

Many devices can use Wi-Fi, e.g. personal computers, video-game consoles, smartphones, some digital
cameras, tablet computers and digital audio players.

1.3. Metropolitan Area Network (MAN)

A (MAN) is a large computer network that spans a metropolitan area or campus. Its geographic scope falls
between a WAN and LAN. MANs provide Internet connectivity for LANs in a metropolitan region, and
connect them to wider area networks like the Internet.

1.4. Wide Area Network
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Wide Area Networks (WANSs) connect networks in larger geographic areas, such as whole world. Dedicated
transoceanic cabling or satellite uplinks may be used to connect this type of global network.

WANSs as computer networking technologies used to transmit data over long distances, and between different
LANs, MANs and other localized computer networking architectures. The Internet can be considered a WAN
as well, and is used by businesses, governments, organizations, and individuals for almost any purpose
imaginable.

1.5. Wireless Wide Area Network

Wireless WAN is a wide area network in which separate areas of coverage or cells are connected wirelessly to
provide service to a large geographic area.

A WWAN often differs from wireless local area network (WLAN) by using mobile telecommunication cellular
network technologies such as WiMAX (often called a wireless metropolitan area network or WMAN) and
cellular digital packet data (CDPD) to transfer data.

These technologies are offered regionally, nationwide, or even globally and are provided by a Wireless Service
Provider for example Zain, Orange and Umniah in Jordan.

Part Il : Network Drawback (Computer Viruses)

Computer Viruses are the most network drawback. Viruses are becoming more and more —
sophisticated and employ many different methods of spreading. While email has been the ‘.—\\ \\\\\,‘\

primary method for the spread of these recent computer viruses, it is not the only method. o ‘
. o . TN
A computer virus can enter a network by CD, floppy disk, internet download, file
transfer and file sharing programs, or by remote users connecting directly to the corporate network with an
infected PC. Once computer viruses gets into a network it can spread to computer in multiple ways.

2.1. Common Types of Computer Viruses

e A macro virus is associated with application software like word and excel. When opening the infected
document, macro virus is loaded into main memory and destroys the data stored in hard disk

e A worm is also a destructive program that fills a computer system with self-replicating information,
clogging the system so that its operations are slowed down or stopped

e Atime bomb is a virus program that performs an activity on a particular date

e Trojan horse is a destructive program. It usually pretends as computer games or application software. If
executed, computer system will be damaged.

2.2. Antivirus software

The Antivirus software protects the computer from computer viruses. The following figure represents the
common types.
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McAfee

Kaspersky

e —— « B

€ RNTIVIRUS 1AV

F PLUS

lf 204 y Internet
Security

2.3. Preventing from virus infection

¢ Always update your anti-virus software at least weekly.

e Get trained on your computer's anti-virus software and use it.

e Have multiple backups of important files. This lowers the chance that all are infected.
e Forget opening unexpected e-mail attachments, even if they're from friends.

e Scan internet downloads.

e Use firewall to protect your computer and network.

Part Il : Internet Overview

3.1. What is the Internet?

The Internet (also known as the Net) is a world-wide electronic network that enables many independent
computer networks to connect together by using a common connection, called an Internet Protocol (IP) which
will dynamically and intelligently figure out a way to get data from one point to another across multiple 1SPs.

3.2. How do | access the Internet?

A computer is “hooked up” to the Internet when the owner subscribes to an Internet Service Provider (ISP)
and has a browser installed on to the computer. An ISP is a company that will allow you to use their computer
connections to access the Internet for a fee.

To be able to access all the internet has to offer:

1. You will need an internet account with an internet service provider (ISP). ISPs like Orange provide these
accounts usually for a monthly fee, much like a phone service. You might also need to have somebody come and
install a line into your home.

2. You will also need what’s called a modem (or modem router). Your ISP will be able to sell you a modem when
you set up an account with them.

3. Once you have an account and a modem set up (the ISP will guide you through setting up the modem), you just
have to plug your computer into the modem to access the internet.

What you need to
connect to the Internet?

p— 3.Computer
Internet 1.ISP 2 .Modem
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There are a number of different ways to access the internet. There are five major types of internet access:

1.

3.
4.

Old fashioned dial-up. You can’t make or receive phone calls while connected via dial-up to the
internet.

ADSL., which uses a special modem to transform your existing phone line into a high-speed phone line.
Because it is a broadband connection, you can chat on the phone at the same time you use the internet.
ADSL is the most common type of broadband connection and the easiest to set up at home. Most ADSL
services require that you have a phone service, but there are also so-called ‘naked’ DSL services that
require no phone service.

3G/4G which uses mobile phone networks to connect you to the internet.

Satellite, which transmits data from satellites.

Not all services are available in all areas. Your ISP will tell you which ones are available to you. While different
internet connection services have strengths and weaknesses, they all connect you to the same internet.

3.3. Different Speeds and Quotas

When signing up for an internet account, you may be dazzled by the number of different and confusing options
available.
There are different speeds and different monthly quotas available on different accounts.

Speeds are measured in kilobits per second (Kbps) or megabits per second (Mbps), with 1mbps equal to
1000kbps. A dial-up connection works at 56Kbps, while ADSL can go as fast as 24Mbps — more than
400 times faster than dial-up.

The monthly download quota determines the volume of data and media you can download before your
ISP either cuts you off, slows down your connection or charges you extra (depending on the specifics of
your internet account agreement).

Volumes are measured in gigabytes (GB) and sometimes megabytes (MB), where one GB is equal to
1000MB. You’re not likely to go over your limit just looking at web pages and sending emails, but if
you watch a lot of online videos you might reach your monthly limit.

Part IV : The Internet and Everyday Life

New uses for the internet are being invented every day. There are literally hundreds of millions of web pages
and services available. It’s very easy to sink hours, days, weeks and months exploring all the internet has to

offer.

The following uses are the most common:

1.
2.
3.

4.
S.

Sending emails, which are letters that can be sent for free to anyone and arrive instantly.

Looking up news, weather, health information and sports results, government information and forms.
Searching for information on just about any topic, such as Flight timetables, phone numbers and just
about anything else you can think of!

Doing all your banking, taxes and business online.

Sharing your photo and video collection, and seeing the shared collections of others.
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Talking or video chatting with online friends — at any time, for free.

Participating in discussions on topics you find interesting, with people from around the world.
Downloading and watching movies, reading book reviews or watching sports.

E-commerce, buying and selling goods from online stores.

© © N>

Part V : The Browser

An Internet browser is a computer application that will give you access to the Internet and navigate the World
Wide Web.

The World Wide Web (WWW), also known as the Web, is made up of millions of documents called web
pages. Web pages can include text, pictures, video and sound. Most organizations on the Web have sets of
pages, which are linked together. These sets of pages are called websites. You can use the Web to get up-to-
date information about almost any subject.

5.1. Internet browsers Examples

Internet Safari Mozilla Netscape Google
Explorer FireFox navigator Chrome

@ee@-c

Each of these Internet browsers will interpret the computer code in web sites, in order to display text and
graphics (on these sites), provide encryption security, play video and music, and display links to other web
pages.

5.2. Website Address

A domain name is the root web address for a Website. Domain names function on the Internet in a manner
similar to a physical address in the physical world. Each part of the domain name provides specific information.
These pieces of information enable web browsers to locate the web page. The naming system is closely
regulated in order to prevent confusion or duplicate addresses.

An Internet address is in alphabetic form. Domain names must have at least two parts:

e the part on the left which names the organization (website name),

e And the part on the right which identifies the highest subdomain (extension), such as the country or the
type of organization.

Extension
Stands for World Wide Web —™———
http://www_.bau.edu.jo

MName of site
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"bau.edu.jo" bau is the organization and edu.jo identifies it as an educational institution in the Jordan. There
are only a limited number of such highest subdomains. For example:

subdomain name usual meaning

.ac university etc in UK

.CO business in UK

.com commercial business

.edu Educational institutions
.gov Government site anywhere
.0rg Organizations (nonprofit)

Part VI : Internet Explorer Browser

First, you need to open the web browser. That means clicking the Internet Explorer icon. When the program
starts, it will automatically go to a home page. It is a web page that is configured to be displayed first when a
Web browser is opened.

Amazgn W eBay Toshiba Places 2 slery » - 8 - - v P

e m Fowhing Lichy
Heizon FRoiniadia Mandsia, 1913 - 2013

Google jo afered m 5 = ‘

When the browser opens, you’ll see buttons, icons and headings representing various features, tools, search and
navigation controls. From left to right:

Back: Go back to a previously viewed web page.
Forward: Go forward to a previously viewed web page.
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Address bar: Enter a website address or a search term here to find what you’re looking for. It
is also called as Uniform Resource Locator (URL).

Search engine selector: Click the adjacent down-arrow to choose  preferred search

engine (google, bing, yahoo)

2. The AutoComplete feature in Internet Explorer lets you more quickly fill out web forms
and go to websites you have visited in the past.

3. Security report: clicking this icon displays a report describing the certificate used to
encrypt the connection and the certifying authority that issued the certificate. The security
report also provides links to more detailed information.

4. Refresh: Reloads web page, so you know you’re looking at the most current version.

X

Tab: Shows the title of the website in the open window.

Click on that icon a new tab will appear. You can go to any address you like in this new tab.

1. Home: Reverts to web browser’s home page, the one you see when you first start Internet
Explorer.

2. Favorites: Displays websites saved as favorites. When you click on Add to Favorites. The
current web page will now be added to your Favorites list. Whenever you click on Favorites
again, you will see it.

3. Tools: Access zoom, print, internet options and other functions.

Menu bar: can be turned on or off in Windows Internet Explorer. That is representing various
features and functions.

Favorites bar: that enables one-click access to your favorite web sites.

Command bar: offers easy access to almost any setting or feature in Internet Explorer. You
can customize the Command bar buttons to suit your preferences.

Status bar: it displays messages such as a webpage's download progress.

Q0060 ©60

Part VIl : Changing Your Home Page

Home page is the page that the browser opens to whenever you start it up. To change your Home page.
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1. First you go to the web page that you’d like to set as your home.
2. Now right-click on the Home button. A drop-down menu will L] _gg_]

appear. nt 3 ,
| ¥ Menubar
v Favorites bar
3. Move your mouse to Add or Change Home Page and left- 7| Comrandbas
click. | ¥ Status bar
a. Select Use this Web Page as Your Only Home Page. AVG Security Toolbar
b. You can have several pages as your home page; with each Google Toolbar

page open in its own tab. Select Add this Webpage to

your Home Page Tabs v Lock the toolbars

Show tabs on a separate row

Add or change home page

Part VIl : Search Engine

A search engine is a website that you can use to look up web pages.
There are many different types of search engines made by different companies, the most popular ones are:
e www.bing.com Bing is Microsoft’s alternative to Google.

e www.google.comThe home page of Google, the world’s largest search provider.
e Www.yahoo.com

But the most popular is Google. To search the internet with Google, type www.google.com into the Address bar
of your web browser.

@ { '[;:, www.google.com

The Google main page will appear. In the middle of the page is the Google Search bar.

3 7
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How to read search results

Google's goal is to provide you with results that are clear and easy to read. The diagram below points out four
features that are important to understanding the search results page.

Go¢ >gl€ goge (o) dtaemasse
Web
1
Google «—

Enables users to search the Web, Usenet, and images. Features include PageRank. caching
and transiation of results, and an option to find similar pages

vaww google \ ¢ 2
Google Iimage Search 3

The most comprehensive image search on the web. Advertising Programs - Business
Solutions - About Google ©2007 Google

images googjf! comy - bK

Google Groups \ 4

Enables users to search and browse the Usenet archives which consist of over 700 milkon
messages. and post new comments
groups google conV/ - 22k ‘

The title: The first line of any search result is the title of the webpage.

The snippet: A description of or an excerpt from the webpage.

The URL.: The webpage's address.

Cached link: A link to an earlier version of this page. Click here if the page you wanted isn't available.

el NS

Part IX : Saving or Copying images

1. Select the image —> right click and then choose either:
Copy then paste it in the desired place.
or
Save Picture as then save it in the desired location so you can find it later.

v
£ e s e
[« I g |
|
ausin = “
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Part X : Saving a web page

Choose File > Save As menu item. In the dialog box that opens, you have several file types option. Select your
option for saving the page as a different file-type.
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Part Xl : Sign up using Yahoo Mail

To create an email account in Yahoo mail:

1. Go to this link, mail.yahoo.com. Or go to Yahoo website (www.yahoo.com). Then click on Mail icon, Fill
in the required fields and read on the terms and agreements. After accepting all the terms g5 ..
and agreements you will automatically be able to open your Yahoo account.

. YAHOO)]
2. Click on Create New Account button to start.

3. The Sign up window will appear. Fill in the required fields and read on the
terms and agreements.
YARQQ!

Sion up [

Ouly letters, numbers,

underscores, and one dot

() are allowed

l— Password Rules :
v

. # 8.32 characters
= v +952
Hupper and
lowercase letters
Huumbers

- 062

| mgirwe 3 the Yahoo Terms and P
Craata account

4. After entering your information click on
Create account button. YAHOO! o

MAXTOOB Lglss

Sign up

5. After accepting all the terms and agreements A Ahmed
you will automatically be able to open your  Lianmen2a
Yahoo account.

= -~ +962 799999999
15 April 1990

@ Male

= v~ +962 778888888

| agree to the Yshoo Terms and Privacy including Cookie Use
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LAB.4 : Internet and Computer Networks

Appendix: Social media networks
1) Facebook

www facedook.com

vl w Wiy
e EE==———y)
facebook .
Facebook helps you connect and share with S'gn Up
the people in your life. Its free and always will be
Birthday
Mo [» Doyle Your (o

Female Male

Ly a by rese (we

2) Twitter

Taittercom

Join Twitter today.

Ful name
Emal aodress
Create a password

Choose your usermame

Croate 1y atsout
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